


Welcome to Mac OS X—the next
generation Macintosh operating
system. Thank you for participating
in the Public Beta release of

Mac OS X. Your comments and

feedback are appreciated.

This book helps you start using
Mac OS X. First install the software,

then discover how easy it is to use.
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Before
Installing

Important Mac OS X Public Beta is pre-release software provided on a trial basis for a limited
time. It’s being made available to you for evaluation and development purposes only. Do not use
Mac OS X Public Beta in a commercial operating environment or with important data. You should
back up all of your data before installing this software and regularly back up data while using the
software. Your rights to use Mac OS X Public Beta are subject to the terms of the software license
agreement that accompanies the software.

If you want to use only Mac OS X and Mac OS X applications, you can install Mac OS X on your
computer by itself.

If you want to continue using your Mac OS 9 (called “Classic”) applications with Mac OS X, you
need to keep your existing Mac OS 9 system on your computer. There are two ways you can install
Mac OS X so that you can use Classic applications:

Install Mac OS X on the same disk or disk partition with Mac OS 9. Doing so does not change
Mac OS 9 or the other contents of your disk, except to move them into a folder named
“Mac0S9.”

Install Mac OS X on a separate disk or disk partition, keeping Mac OS 9 on its own disk or disk
partition. If you use separate disk partitions, be sure Mac OS 9 is installed on the first partition.

If you don’t have Mac OS 9 installed on your computer already and you want to use Classic
applications, install Mac OS 9 before you install Mac OS X.



/ Mac OS user
Before you install Mac OS X, you may need to update your computer’s firmware. Updaters and So that you can continue to use your Classic

instructions are available at the Apple Software Updates Web site (http://asu.info.apple.com). You Mac OS 9 applications, Mac OS X provides the
may also need to update the software for any device you use with your computer. Check with the Classic environment. When you open a Classic

application, the Classic environment starts up,
manufacturer for the latest update. W mn sl s (O @ Systar,

Updating your computer’s firmware 9 For the experienced

Getting information you need to set up S‘.f Mac OS X tips

When the Installer finishes, you'll need certain information to complete the Setup Assistant. If you
already use Mac OS 9, you may want to use the same network and Internet settings with Mac OS X.

Getting more information
For more information and to provide feedback

If 5o, capture this information in Mac OS 9 before you install Mac OS X. Here’s where to find the about Mac OS X, visit the Mac OS X Web site:
information you need in Mac OS 9 and where to use it in Mac OS X. http://www.apple.com/macosx
In Mac OS X
Settings In Mac OS 9 Setup Assistant Other Applications
TCP/IP TCP/IP control panel Yes Network pane
in System Preferences
Internet Web tab in the Internet Yes Internet pane
control panel in System Preferences
Mail E-mail tab in the Internet Yes Internet pane in System
control panel Preferences and in Mail
Dial-up connection Remote Access and PPP Connect and Network
(PPP) Modem control panel pane in System Preferences
Printers Chooser or Print Center

Network Browser

Servers Chooser or “Connect to Server” from
Network Browser the Go menu in the Desktop

If you don’t know your Internet and network settings, contact your Internet service provider (ISP)
or system administrator.



P e Insert the Mac OS X CD and restart your computer while holding down the C key.

Select the language you want to use.

y The language you select will be used by the Installer, Setup Assistant, and Mac OS X. To change
a7 the language after installation, use the International pane in System Preferences.
. Follow the onscreen instructions.
Installing

When the installation is finished, your computer restarts.
Mac OS X

After installation finishes and your computer restarts, Setup Assistant appears. It guides you
through setting up important features of Mac OS X, including

entering your network, Internet, and email settings
giving a name and password to a user account for your computer

This user is an administrator. When you log in as an administrator, you can add other users and
change system settings that require an administrator password.

Important Be sure to remember the name and password you give this user. You'll need to type
them exactly the same way (including capitalization) each time you log in. If you forget your
password, you will not be able to access your files and you may need to reinstall Mac OS X.



Logging in

Each time you start up your computer, the login dialog appears. The first time you start up
Mac OS X, log in as the user you created with Setup Assistant.

Name:

Password:

¢
MacOS X

© ©

Restart  Shut Down

(@

Log In

}_

— Type the user name

and password here,
then click Log In.

( For the experienced
:;- Mac OS user

Mac OS X is designed for computers that are used
by more than one person or that are on a network.
To provide greater security for your documents and
your computer, Mac OS X requires you to log in.
To have the greatest access to your computer, log
in as an administrator.

L 7
. Mac OS X tips

Getting help

Throughout this book, you’ll see questions like the
one below to search Mac Help. To get answers to
these questions, choose Mac Help from the Help
menu, type the question, and click Ask.

[-X:X:] Mac Help

[ | Ay
Type the
Quick Clicks question
/ here, then
click Ask.
MacHelp
o) 8o

'%‘ ~ Searching Mac Help
. 3/ How do I use Help?



When Mac OS X starts up, you see the Desktop, a Finder window,

and the Dock at the bottom of the screen. Click the applications in the

Dock to begin discovering what you can do with Mac OS X.

This menu includes the commands
for setting application preferences
and quitting.

Use Finder windows to access
and organize your documents
and applications.

QuickTime Player File Edit FICYTES QTV  Window
Normal Size #®1
Double Size #¥2
Fill Screen #3

Show Sound Controls
Show Movie Properties

Choose tanguage

Proposal Greatest Hit.mp3

Save as: Power Mac G4 Cube

Where: {Documents  T#] [¥]

Cancel { save )

TextEdit




Using the window buttons

Mac OS X windows have three buttons in the top-left corner. Here’s what they do:

Click here to Click here to minimize the
close the window. window, which puts it in
the Dock.
é f——Click here to enlarge or

reduce the window.

The Desktop application menu

When you use the Desktop, you'll see the Desktop application menu.

Choose this to set Desktop,
RTINSV —Dock, and disk preferences.
Desktop & Dock Preferences. ..

System Preferences... —————————Choose this to change
Serices computer settings.
Hide Desktop 88H

Hide Others

Show All

Log Out... 3q-+—Choose this to log out.

"~/ Mac OS user

When you log in, a Finder window shows your
“home” folder—a private space on the computer
for your personal documents and applications. So
that several people can use a computer, Mac OS X
provides a home folder for each user.

9 For the experienced

va
Y Mac OS X tips

Finding your home folder

Your home folder is named with your user name.
It is in the Users folder on the Mac OS X disk. You
can go to it quickly by clicking the Home button in
a Finder window.

Changing the Desktop background

To change the Desktop background, choose
Desktop & Dock Preferences from the Desktop
menu and click the Desktop tab.

Changing computer settings

You use the System Preferences application to
change settings for your computer (instead of
control panels as in Mac OS 9).

)q ~ Searching Mac Help
e '3/ How do I use the Desktop?



Finder
Windows

Finder windows are the gateway to your computer and network.

In a Finder window you see your documents, folders, disks, and servers.

Click a toolbar button to

see your disks and servers,

open your home folder, Click here to

or open other folders. change the view.

Desktop File Edit View Go Special Window Help &

Finder

1 @ A=W

e & @ A B D

{Comouter] | Home | | Favorites| | Amps | | Docs | | Users |
=m

e jandoe I"ﬂ

L
o

Documents Birds.tif Greatest Hit.mp3

Public Flowers.tif iMac.mov

B s 9

Library Plant.tif House.mov




Finder views

You can view Finder windows in icon, list, or column view.

886 In list or icon view, double-click
a folder to see its contents
o in the same window.
—Hame = w?;.mnrm See K
E3 Agplications Today a1 9:45 AM Fi
& Addres sBook Wednasday, pely 15, 200 170 KB Apphcation
alculatar T (2]
Cateulator Wi =
Classsc Tm
Clack Tow
> GrabBa T . s
» 4 internet Explorer 5.5 Tod M o
B Ky Cags T = I — ==
& Mai we Shows the folders
Music Playar Frie .
# Freview T f that contain the
B QuickTome Payer T I ¢
e ™ = 1= selected item.
:hckl!; .I ol Applications u
& Sysram Preferances T
>
Mac0s9 Users ‘Welcome to Mac 05 X

ene

B Sk ¥ Agplications 1 Addrestiook

= Pt Bk Library Caseulaor

o 13 Macisa 9 Clhswe

— Lsars Clock

e Metwark |4 Welcoma to Mac 05 X | Grabag
2 Vielp Wewer
(¥ Inzerner Explorer 5.5
0 Key Cies

& Mai

& Systam Proferences
7 TeutEdn
Utlities

In column view, click a folder to

see its contents. Column view
= shows the path to the selection.
Use column view to see how
your disk is organized.

Kind: Applcation
Saze: 900 KO

= ok Shows information about the

Mo Feck: 172009 item. If it'’s a picture, you see
a preview. If it's a movie, you
can play it here.

For the experienced
Mac OS user

To make it easier for you, Mac OS X reduces the
number of open windows. When you double-click
a folder in a window, the folder’s contents appear
in the same window. If you want to open a
separate window, press the Option key when you
double-click the folder.

7
Y Mac OS X tips

Opening another Finder window

If you need to open another Finder window (to
move or copy a file, for example), choose New
Finder Window from the File menu.

Moving, copying, or making

an alias to a file

To move a file to another folder on the same disk,
drag it. To copy the file, press the Option key while
you drag. To make an alias to it, press the Apple
and Option keys while you drag.

Changing the look of Finder windows
You can change the look of all Finder windows in
icon or list view, or just the active window. To
change the way Finder windows look, choose
Show View Options from the View menu. You can
change the background color or add a picture.

)q ~ Searching Mac Help
e ‘y' How do I use Finder windows?
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Accessing
Files

Use the toolbar buttons to quickly access your disks, servers,

applications, and documents.

™

Computer

G

Favorites

Computer

Your disks, CDs, and Network (where you can access connected servers)

Home

Your home folder—your private space on the computer (named with your user name)

Favorites

The Favorites folder in your home folder (access these items quickly when you save or
open a document)

Apps

The Applications folder on your Mac OS X disk

Docs

The Documents folder in your home folder

Users

The Users folder on your Mac OS X disk, where each computer user’s home folder is
located



How Mac OS X is organized

Mac OS X is organized in a simple way.

8geée
e
Cemputar
=) ;
Mac D5 X Metwork Fi re-';\mﬁsk

ege Finder

Agglications Library
. = 3
= = =
MacCsa Users ‘Welcome ta Mac 03 %
808 Finder

= = =
Documents Library Puibslic

When you click the Computer button, you see
your Mac OS X disk and any other disks you are
using. Open Network to see the servers you are
connected to.

The Mac OS X disk contains a folder for
applications. The Library folder contains fonts,
preferences, and other files. If you see a
MacOS9 folder, it contains your Classic
applications and documents. The Users folder
contains the home folder of each user.

Your home folder contains your documents. Your
Favorites folder is in the Library folder. If you turn
on file sharing, other users on your network can
access your Public folder.

For the experienced
Mac OS user

In Mac OS X, the Applications folder is protected.
If you drag an application out of the Applications
folder, Mac OS X makes a copy of it. To make an
alias instead, press the Apple and Option keys
while you drag the application.

L 7
i\ Mac OS X tips

Accessing favorites

When you save or open a document, a pop-up
menu shows recently opened items and items in
your Favorites folder. You can add items to the
Favorites folder.

Turning on file sharing

To turn on file sharing, open System Preferences
and click Sharing, then click the Start button. If you
turn on file sharing, other users on your network
can access your Public folder (in your home folder).

Setting access privileges to a folder

You can give other people who use your computer
access to items in your home folder and control
access to your Public folder. To control access to
a folder, select it and choose Show Inspector
from the File menu, then choose Sharing from

the Show pop-up menu.

Ejecting disks

To eject a disk, drag its icon to the Trash in
the Dock.

,)q ~ Searching Mac Help
. “/' How is my hard disk organized?

11



The
Dock

The Dock makes it easy to open applications and documents, and
switch between them. To open an application in the Dock or make

an application or document active, click its icon.

This side of the Dock Drag this bar up or down
|shows application icons. to resize the Dock.

12
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|This side of the Dock shows
application is open. documents, folders, servers,
Web sites, and QuickTime
TV channels.

The three dots indicate the



What’s in the Dock

Desktop

Click to see a Finder window and the Desktop menus.

Mail

One of the applications included in the Dock when you install Mac OS X.

Preview

An application icon added to the Dock.

Document

A document added to the Dock.

Web site and servers

A server or Web site added to the Dock. Click to open the Web site in your
browser or mount the server.

Minimized window

You can put any window in the Dock. Click to open the window.

Trash

Drag files here to throw them away.

) For the experienced
/' Mac OS user

The Dock consolidates several Mac OS 9 features.
Keep items you use frequently in the Dock instead
of using the Apple menu. Click items in the Dock
to make them active, rather than using the
application switcher.

K}f Mac OS X tips

Adding icons to the Dock

You can add icons to the Dock for such items
as applications, documents, folders, servers, and
Web sites. To add an icon, drag it to the Dock.
To remove an icon, drag it from the Dock.

Changing how the Dock works

To resize the icons in the Dock, make them
magnify, or hide the Dock, choose Desktop & Dock
Preferences from the Desktop menu, then click the
Dock tab. If you hide the Dock, it appears when
you move the mouse to the bottom of the screen.

Opening a document using
an application in the Dock

Drag the document’s icon to the application’s icon
in the Dock.

Switching between applications

In addition to using the Dock, you can press the
Apple and Tab keys together to switch
applications.

A‘- ~ Searching Mac Help

. '3/ How do I use the Dock?
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Mac OS X includes several specially designed applications. Here are the

applications you will use most frequently.

Desktop

Access your applications and documents, get information about your files, and
connect to servers.

Applications

Internet Explorer

Use Microsoft Internet Explorer to browse the Web.

Mail

Send and receive email messages that include pictures and movies.

Sherlock

Find what you're looking for on your disks, your network, or the Internet.

B ,° System Preferences

i ‘ Change computer settings such as Internet preferences.

TextEdit

Create documents with formatted text and pictures.




More applications

In addition to what's in the Dock, the Applications folder on your Mac OS X disk contains useful
applications. Here’s a selection of what's available:

QuickTime Player

Play movies, view pictures, listen to music, watch QuickTime TV.

Preview

Open PDF and graphics files, preview documents before you print them, and save
them in PDF format.

Address Book

Keep all your email addresses and other information about people in one place.

Multiple Users

Add users so that other people can log in to your computer.

Disk Utility

Repair, format, and partition disks.

Grab

Take a picture (a “screen shot”) of anything you see on your screen.

( For the experienced
:;- Mac OS user

To use a Classic application with Mac OS X, just
double-click the application’s icon or a document
created with the application. When you open a
Classic application, the Classic environment must
start up first. To have the Classic environment start
up when you log in, open System Preferences and
click Classic, then select the “Start up Classic on
login” checkbox.

8 ;/'
>'\ Mac OS X tips

Updating your software

Mac OS X includes the Software Update
application so that you can easily get the latest
version of your Mac OS X applications and system
software.

Forcing applications to quit

If you can’t quit an application, press the Apple,
Option, and Escape keys together, select the
program in the window, and click Force Quit.

% & Searching Mac Help
. "/' How do | use my applications?

15
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Use the System Preferences application to change your computer

settings. To open System Preferences, click its icon in the Dock.

Then click a button at the top.

Changing
Setti ng S Click here to see

If this is a locked padlock, click Click a button here or in the
all of the system it and enter an administrator Show All pane to see the
preferences.| |paSSWOrd to change the settings. settings you want to change.
System Prefs Pane Edit Window [Help ®

System Preferences - Date & Time

Date & Time

= @ & &

Menitors Network Sound Startup Disk

m Time Zone 1 Network Time

Date

Time

16:13 0]
Ty

L— 5/ Click the lock to make changes.




Important settings panes

These are some important settings panes in the System Preferences application. To change some
settings, you need an administrator password.

Classic

Select settings for the Classic environment.

Internet

Enter settings for your email and Web browser.

International

Change the language your computer uses and the way dates, time, and numbers
are displayed.

Network

Enter settings to connect to your network.

Password

Change your login password.

E Sharing
Turn on file sharing so that other people on the network can access your Public folder.

Startup Disk

Select a startup disk for your computer. You can start up using Mac OS 9 or Mac OS X.

"~/ Mac OS user

With System Preferences, you can select all the
settings you used to change with control panels in
Mac OS 9.

9 For the experienced

7
Y Mac OS X tips

Setting application preferences
Applications also have preferences. To set
preferences for a Mac OS X application, choose
Preferences from the application’s menu.

Preferences for Mac OS 9 applications remain
where they were, usually in the Edit menu.

Returning to Mac OS X from Mac OS 9

In the Startup Disk pane, you can select a Mac OS
9 startup disk for your computer to use when you
restart. To start up using Mac OS X again, use the
System Disk control panel (in the “Welcome to
Mac OS X” folder), to select your Mac OS X disk.
You cannot use the Mac OS 9 Startup Disk control
panel to select a Mac OS X disk.

Adding items to the favorites toolbar

To add a preference button to the favorites toolbar
(at the top right), click Show All and drag the
button to the toolbar. To remove an item, drag it
from the toolbar.

)q ~ Searching Mac Help

. ‘y' How do | change computer
settings?

17
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Mac OS X provides fully integrated Internet and network capabilities,
including Web browsing, Web sharing, access to network servers,

and file sharing.

Getting
Connected

Use PPP Connect to set up
Use Internet Explorer to and connect to the Internet
browse Web sites. using a dial-up modem.

Internet Explorer File Edit View GCo Favorites Tools Window

Ld

Phone Number:  555-1212

eoe
9 @ @

Eack Forward Stop Refresh  Home

PEPERR (@) hitp ./ fwww apple.comy]

-

d T Store l iReview [ iTools l iCards QuickTimew Support ‘MacOSX

Hot News Hiring Hardware Software MadedMac Education Creative Small Biz Developer

a0y J

s

Aaogsi

yumag

Apple 7.

2
=
-
g
]
=

ns

Two brains are
better than one,

Power Mac G4

13pIoy 200y




Accessing network servers

When you choose “Connect to Server” from the Go menu (in the Desktop), this dialog appears.

Choose the type
of server here.

Connect to Server }

Use these pop-up menus to
see neighborhoods, connect to
favorite servers, and connect to
servers you’'ve used recently.

=
AFP Servers |

(elm) o « -

Name

Jjandoedesign.com

55.555.55.555
3 info_jandoedesign.com

Double-click to open a
neighborhood, then double-
click a server to connect to it.

(== ]3I0

URL Iafp:/}aﬂserver.jandoedesign.com

———You can also type the name of

&) Sitems " Add Neighborhood .. (" Cancel  Connect)

a server here to connect to it.

If you choose You will see

AFP Servers AppleShare IP file servers
Mac OS 9 file sharing folders (only if over TCP/IP)
Mac OS X shared Public folders

Web Servers Mac OS 9 Web Sharing sites

Mac OS X Web Sharing sites

After you connect to a server, click the Computer button (in a Finder window) and open Network,
then open the Connected Servers folder. If you type the address (URL) of a Web site, it opens in

your Web browser.

/ Mac OS user

To connect to servers in Mac OS X, you use
“Connect to Server” rather than the Chooser or
Network Browser.

if Mac OS X tips

Entering your Internet

and network settings

To enter your Internet and network settings, open
System Preferences and click the Internet or
Network button.

9 For the experienced

Turning on AppleTalk

If you need to use AppleTalk, open System
Preferences and click Network, then choose
AppleTalk from the Show pop-up menu.

Starting a dial-up connection

to the Internet

If you use a dial-up modem to connect to the
Internet, you use a PPP connection. First, use the
Network pane in System Preferences to set up
your network. Then open PPP Connect (in the
Utilities folder), enter the information, and click
Connect.

Disconnecting servers

To disconnect from a server, drag its icon to the
Trash in the Dock.

k‘- ~ Searching Mac Help

¥ ./ How do I connect to
b the Internet?
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Use the Mail application included with Mac OS X to send and
receive email. Your email can include pictures, sounds, and

movies as well as text.

Mailboxes are shown in this

drawer, which appears when Click here to write
you click Mailbox. a message.
Mail File Edit | Message Mailbox Format Window Help &

eeeé il.mgc.com (8 unreag)

slaellee—

| e
Delete oy Reply All Compose || Mallbox | | Get Mail

1 @ /sender 'Subject Dat 3
= POP: jandoe @ mail.mai @ Apple iTools Team iTools Update - April 5, 2000 Apr5 03:35PM

INBOX (8 unread) Bill James New computer Apr 11 05:25 PM

I 2 Apple Computer Inc. Welcome to iTools! Apr12 0L:21PM

wPersonal Mailboxes
Art
Benefits
Design Projects
Drafts
Friends
Fun

Sent Messages Y 3
To Be Delivered HiJan,

Travel f Take a look at my
Power Mac G4 Cube.
Isn't it great?! Did you
ever get your montor?

-Bill




Sending email

To send an email message, click the Compose button, type the address, and write your message.

Click these buttons
to see your addresses.

Gotit!

6cé ;

< = N © ¢

Send Favorites Attach

To: Bill James <bj@mac.com>

Cc:

Subject: Cotit!

Wow! Check this out...

The new 17 inch Apple Studio Display.

As you type Mail selects
matching addresses from your
address book. To select the one
you want, press the Tab key.

To add a picture, sound,

or movie to your message,
drag it from the Finder to your
message.

Mac OS user

The Mail application is fully integrated into
Mac OS X. In addition to using font styles, you
can put attachments directly in your messages.

() For the experienced
\_'.
A

L7
b "
. Mac OS X tips

Setting up mail

When you used Setup Assistant, you set up how

to send and receive your email. To change settings

or add other accounts, choose Preferences from

the Mail menu. If you log in as a new user, the first

time you open Mail you'll be asked to set up your

Mail account.

Changing the active mail account

Mail lets you receive email from more than one
email account. To make an email account active,
click the Active column next to the account’s name
in Accounts Preferences. To see your messages,
select the account’s mailbox in the Mailboxes
drawer.

'%‘ ~ Searching Mac Help

. 3/ How do I send and receive
email?

21



Mac OS X provides a new way to print your documents. First use

the Print Center to connect to the printers you want to use.

Then print your work.

Printing

If you see a list here,
double-click a printer to
add it to the Print Center.

Choose how to connect
to the printer here.

PrintCenter Pl

nters Edit  Queue  Window Help

Printers

W

Internet Address or Name: colarprint.compary.com

O verify
| — s

Printer Name: ColorPrinter

Printer Model: | LaserWriter

_ime to get an iMac DV




If you are using a USB printer, it’s automatically set up for you. Before you can print a document to
a network printer, you need to connect to at least one printer using Print Center. If you haven’t
connected to a printer when you print the first time, Print Center opens. In the Printers window
click Add Printer, then select how to connect to the printer. If a list appears, double-click the
printer you want to add. Otherwise, enter the requested information.

To print a document, choose Print from the File menu. The Print dialog opens with the default
printer selected.

Print

Printer:  Generic Printer ?—Use the default

Saved Settings:  Standard G| p!’lﬂter or ChOOSe a
different printer here.

Pages & Copies ﬂ
Copies 1
Pages: @Al = =
O From: 1 to: |1
,:_P\ lrFreviewr /Cantrelr € Print

Click here to see how
the document will look
before you print it.

In the Print dialog, you can click Preview to open the Preview application and see how your
document will look. From Preview you can print the document or save it in PDF format.

-

) For the experienced
/ Mac OS user

You use Print Center to select and set up printers
(rather than the Chooser). Mac OS X does not have
desktop printers; you can select a printer right in
the Print dialog.

\\ Mac OS X tips

When you print a document, your default printer is
automatically selected. To change the default
printer, select a printer in Print Center and choose
Make Default from the Printers menu.

Before you print a document, choose Page Setup
from the File menu to select page options.

!1 ~ Searching Mac Help
. " / How do I print my documents?
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Troubleshooting

24

You see a message about updating your computer’s firmware.

If you see a message that you need to update your computer’s firmware, you should do so before
proceeding with the installation. The updater and instructions are available on the Apple software
updates Web site (http://asu.info.apple.comy).

The Installer cannot repair your hard disk.

If necessary, the Installer tries to repair your hard disk before it installs Mac OS X. If you see a
message that the disk can’t be fixed, start up your computer using your Mac OS 9 CD and try to
repair it using Disk First Aid (on the CD).

If you can’t repair the disk using Disk First Aid, you may need to reinitialize it. Back up your disk
before you erase all the files on it. Start up your computer using your Mac OS 9 CD, then use the
Drive Setup program (on the CD) to initialize the disk. If you want to use Classic applications,
install Mac OS 9 and copy your Classic applications and documents from your backup. Then install
the Mac OS X software.

The Installer cannot update the hard disk driver.

The Installer cannot update non-Apple hard disks. Use the disk utility recommended by the
manufacturer of your hard disk to update your drivers before installing Mac OS X. Make sure to use
a version of the utility that is compatible with Mac OS X.

Installing Mac OS X was interrupted and now you can’t restart your computer.

If this happens and you have Mac OS 9 installed on your computer, try restarting your computer
while pressing the Option key to start up using Mac OS 9.

If you cannot start up using Mac OS 9, insert a Mac OS 9 CD in your computer and press the C key
while restarting your computer. Open the Startup Disk control panel and select your Mac OS 9 disk.



First, make sure you are entering your password with the same capitalization and punctuation that
you used originally. If you still can’t log in, log in as an administrator, open the Multiple Users
application, and change your name or password.

If your network services don’t seem to be working, try these solutions:
Make sure that your computer is connected to the network.

Check your computer’s network settings (in the System Preferences application).

See your server administrator to make sure the server you are trying to connect to is available.

If you can’t quit an application, you can force it to quit. Press the Apple, Option, and Escape keys
together, select the program in the window, and click Force Quit. (You do not need to restart your
computer.)

Important When you force an application to quit, any unsaved changes to documents are lost.

In some cases, you may need to start up your computer using Mac OS 9. For example, you may
need to do this to use a device or program that is not compatible with Mac OS X. To start up using
Mac OS 9, open System Preferences and click Startup Disk. Select your Mac OS 9 disk and restart
your computer.

If you start up your computer with Mac OS 9, then want to start up with Mac OS X, use the System
Disk control panel (in the “Welcome to Mac OS X” folder) to select your Mac OS X disk. You can’t
use the Startup Disk control panel included with Mac OS 9 to select a Mac OS X disk.

-

X Mac 0 X tips

Free online information is available and telephone
support is provided on a pay-per-incident basis for
installation, configuration, and troubleshooting. Visit
the Mac OS X Support Web site at the following
location for details:

http://www.apple.com/support/macosx/

To search for solutions to problems you are having
with Mac OS X, open Mac Help, type a question,
and click Ask.

1q ~ Searching Mac Help

¥ ./ What's the latest news
about Mac OS X?
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